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South Coast Air Quality Management District 

Net Emissions Analysis Tool (NEAT) Getting Started Guide 

 

Introduction 
The Net Emissions Analysis Tool (NEAT) is a modeling tool, developed by staff at the South Coast Air 

Quality Management District, which calculates the changes in emissions of NOX and greenhouse gases 

and evaluates the costs associated with switching residential appliances to cleaner and more efficient 

technologies.  NEAT is specifically tailored to analyze the effects of new residential technologies in the 

South Coast Air Basin of California (SoCAB), and it is designed to calculate emission changes with respect 

to a baseline mix of technologies that is based on the 2009 Residential Appliance Saturation Survey 

(RASS).  The tool allows the user to switch residential technologies per household type (single, multi-

family and mobile home) and individual climate zones, and uses comprehensive rate structures that 

represent all the utilities that are specific to the various regions present in the SoCAB.  For example, one 

can use NEAT to analyze the electrification of residential appliances, and its impact on emissions and 

costs due to shifting electricity and natural gas use. NEAT is a holistic tool that is designed to calculate 

changes in emissions and costs for a population of homes. It is not suited for modeling a specific home.  

NEAT is equipped with a comprehensive modules that allows to add residential solar panels and 

calculate its costs and benefits.  The tool accounts for how much panel area is available in an average 

single family and mobile home household in each climate zone.  The amount of electricity that can be 

generated by the panels is calculated using NREL’s PVWatts calculator. The solar panel module allows 

the user to input parameters related to the type of solar panel (i.e. standard, premium, and thin film), 

system loss, inverter efficiency, DC to AC efficiency, and panel tilt angle.  Hourly solar and 

meteorological data used in the module is based on representative typical meteorological stations 

selected for each climate zone.  The cost of the panels include installation and electricity savings based 

on zone-specific electricity rates.  The module calculates the costs of various size configurations and 

finds the panel area that minimizes the overall cost.  

With the parameters input by the user, NEAT simulates a mix of 15,000 homes that is representative of 

the appliance technology mix in each climate zone and each housing type.  The results from NEAT 

simulations provide a distribution of homes with varying emission changes and costs per unit of 

emission change.  The tool allows the user to screen for homes with the most cost effective appliance 
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changes.  Along with other applications, the tool can be used to constrain the amount of funding used to 

implement an incentive program targeted to switch appliances and design incentive programs to 

maximize emission reductions with limited financial resources.  

System Requirements 
NEAT must be installed on a Windows machine with at least 8 GB of RAM. It may be possible to run 

NEAT on a computer with less memory, but there may not be enough memory to calculate scenarios 

that involve all climate zones or all housing types simultaneously.  

Installation Instructions 
Run NEATInstaller_mcr.exe and follow the prompts. Note that there may be a slight delay after running 

the installer and before the installation window appears. There is no need to set up the “Connection 

Settings”. NEAT must be installed into a folder with write access. If you are unsure which folder to install 

NEAT to, install it to a subfolder in your “My Documents” folder. 

Modeling a Scenario 
NEAT is designed to determine changes in cost and emissions by comparing the “baseline” case and the 

“scenario” case. The “BASELINE TECHNOLOGY MIX PARAMETERS” table indicates the mix of appliances 

in the baseline case and the penetration of each technology for the selected housing category and 

climate zone. The “SCENARIO TECHNOLOGY MIX PARAMETERS” indicates the appliance mix in the 

scenario case with the rows corresponding directly to the “BASELINE TECHNOLOGY MIX PARAMETERS” 

table. When both tables correspond across a row, an equal sign will be visible between the tables and 

no modification of that appliance will occur in the calculation. When the “SCENARIO TECHNOLOGY MIX 

PARAMETERS” table is modified to indicate a change in appliance, a “not equal” sign will appear for all 

rows where an appliance change-out is desired. For the calculation, NEAT assumes that all homes with 

the given type of technology receive the new technology. However, not all homes have the specific 

technology in the baseline case as penetration is typically less than one.  
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There is a significant amount of embedded documentation within NEAT, which is accessible with buttons 

throughout the tool. It is strongly recommended that new users consult the embedded documentation 

when setting up a simulation. However, the following table addresses how to set up a scenario within 

NEAT. Users should refer to the additional embedded documentation as well. 

Desired Modification How to Make Modification and What to 
Consider 

Load a previously generated setup 
file 

Click “Load Setup” under the “File” menu. This looks for files 
with a .setup extension that were created with the tool. 
Ensure that the setup file you are loading was made with the 
same version of the tool. 

Load a previously generated results 
file 

Click “Load Results” under the “File” menu. This looks for files 
with a .results extension that were created with the tool. 
Ensure that the results file you are loading was made with the 
same version of the tool. 

Restart the tool with default values Click “Restart” under the “File” menu. 

Take a screenshot of NEAT Click “Capture Screen” at the top of the tool. Ensure that the 
entire window of NEAT is on the screen. NEAT will 
automatically open the captured image. Users can then copy 
or save the image. 

Demand Panel 
View additional technical 
documentation 

Click “View Technical Documentation” under the “Help” 
menu or click “NEAT Webpage” under the “Help” menu. 

Select a specific housing category Use the “Housing Category” panel on the “Demand” tab. 
Default technology mix parameters change when selecting 
different housing categories. Average technology mix 
parameters, representing the entire South Coast Air Basin 
(SoCAB) are used when “Aggregate” is selected. 

Select a specific climate zone Use the “Climate Zone” panel on the “Demand” tab. Default 
technology mix parameters change when selecting different 
climate zones. Average technology mix parameters, 
representing the entire South Coast Air Basin (SoCAB) are 
used when “All” is selected. 

Load saved technology mix 
parameters 

Use the “Load Saved Parameters” button on the “Populate 
Baseline and Scenario Technology Mix Parameters” panel. 
This operation only accepts .csv files with a specific format. 
These files can be generated automatically by saving the 
current mix parameters with the “Save Baseline and Scenario 
Technology Mix Parameters to File” button. These files can be 
edited with a .csv editor or systematically with a scripting 
language if desired. The light next to the “Load Saved 
Parameters” button should turn green if the data is loaded 
properly. It will turn red if there were errors loading the data.  

Change the efficiency of an appliance Modify the UEC column directly in the “BASELINE 
TECHNOLOGY MIX PARAMETERS” or the “SCENARIO 
TEHCNOLOGY MIX PARAMETERS” tables. Use the tabs to 
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switch between different appliance categories. Default UEC 
values reflect the average of all the appliances in the housing 
category and climate zone. It is highly recommended to 
replace these with actual values when exploring a retrofit 
scenario. When all parameters in the BASELINE and 
SCENARIO table are equivalent across a horizontal row, no 
modification is implemented. Since NEAT is designed to only 
calculate changes in emissions and costs, it is not necessary 
to fine tune the parameters in the appliances that are not 
being modified. 

Change the emission factors of an 
appliance 

Modify the NOX EF and CO2e EF columns directly in the 
“BASELINE TECHNOLOGY MIX PARAMETERS” or the 
“SCENARIO TEHCNOLOGY MIX PARAMETERS” tables. Use the 
tabs to switch between different appliance categories. 
Default emission factors reflect the average of all the 
appliances in the housing category and climate zone. It is 
highly recommended to replace these with actual values 
when exploring a retrofit scenario. When all parameters in 
the BASELINE and SCENARIO table are equivalent across a 
horizontal row, no modification is implemented. Since NEAT 
is designed to only calculate changes in emissions and costs, 
it is not necessary to fine tune the parameters in the 
appliances that are not being modified. 

Change the unit cost and/or the 
installation cost of an appliance 

Modify the Unit Cost and Install Cost columns directly in the 
“BASELINE TECHNOLOGY MIX PARAMETERS” or the 
“SCENARIO TEHCNOLOGY MIX PARAMETERS” tables. Use the 
tabs to switch between different appliance categories. 
Default costs come from a survey of appliance costs. (Data 
sources are available in the NEAT workgroup #2 presentation, 
www.aqmd.gov/NEAT) It is highly recommended to replace 
these with actual values when exploring a retrofit scenario. 
When all parameters in the BASELINE and SCENARIO table are 
equivalent across a horizontal row, no modification is 
implemented. Since NEAT is designed to only calculate 
changes in emissions and costs, it is not necessary to fine 
tune the parameters in the appliances that are not being 
modified. 

Change the penetration of an 
appliance 

Modify the Unit Cost and Install Cost columns directly in the 
“BASELINE TECHNOLOGY MIX PARAMETERS” or the 
“SCENARIO TEHCNOLOGY MIX PARAMETERS” tables. Use the 
tabs to switch between different appliance categories. 
Default values come from the 2009 Residential Appliance 
Saturation Study conducted by the California Energy 
Commission. NEAT assumes the same penetration in the 
baseline and scenario case. 

Replace an appliance Use the “Replace Technology Tool” by selecting the 
technology you want to phase-out with the first dropdown 
menu. This list contains all the baseline technologies. Select 
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the new technology you want to use instead with the second 
dropdown menu. This list contains all of the new technologies 
in the “NEW TECHNOLOGY PARAMTERS” table. One can edit 
or add custom technologies to the “NEW TECHNOLOGY 
PARAMETERS” table. After clicking “Implement”, the 
replacement technology should appear in the “SCENARIO 
TECHNOLOGY MIX PARAMETERS” table. Appliances with “-
9999” values are included in the tool but do not have default 
values. Users must provide their own parameters for each of 
the implemented appliances before performing the 
calculation. 

Edit the hourly energy use profile for 
an appliance 

Double-click a profile in the “NEW TECHNOLOGY 
PARAMETERS” table to edit the hourly energy use profile. 
Profile definitions and an interactive plotting tool to view 
each profile are available after clicking the “View Profile 
Definitions” button. These hourly profiles tell NEAT how to 
apportion the energy use of each appliance on an hourly 
basis. 

Add a custom technology Use the “Add Technology” button to add a row to the “NEW 
TECHNOLOGY PARAMETERS” table. Specify the Fuel, the 
name of the technology, the profile, UEC, NOX EF, CO2e EF, 
unit cost, install cost, and lifetime. Use the “Replace 
Technology Tool” to implement the new technology by 
putting it in the “SCENARIO TECHNOLOGY MIX PARAMTERS” 
table. 

Save list of new technologies Use the “Save List of New Technologies to File” to save all the 
data from the “NEW TECHNOLOGY PARAMETERS” tables for 
all technology categories. These files are written in comma-
separated-value format and can be used in NEAT with the 
“Populate List of New Technologies for Possible 
Implementation” panel. 

Load saved new technologies Use the “Load Saved Parameters” button on the “Populate 
List of New Technologies for Possible Implementation” panel. 
The light next to the “Load Saved Parameters” button should 
turn green if the data is successfully loaded. A red light 
indicates an error. 

Demand Input Summary (for viewing only) 
The Demand Input Summary panel provides a summary of all the appliance changes that were 
implemented on the “Demand” tab. 
 

Power Supply Panel 
Change the natural gas leak rate Use the “Natural Gas Leak Rates” panel in the “Methane 

Emissions from Natural Gas” panel to modify the before-
meter methane leak rate and the before meter 
transmission/storage/distribution leak rate. Note that the 
before meter leak rate includes the before meter 
transmission/storage/distribution leak rate. Selecting 
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“Custom Value” makes the “Before Meter Leak Rate [%]” and 
the “Before Meter Transmission/Storage/Distribution Leak 
Rate [%]” input boxes editable. Users can also change the 
behind meter methane leak rate with the “Behind Meter Leak 
Rate [%]” dialog box. Click the “More Information” button on 
this panel for additional details about these leak rates. 

Change the time horizon for the 
global warming potential 

Use the “Global Warming Potential” dropdown selector in the 
“Methane Emissions from Natural Gas” to select the desired 
time horizon. 

Change the heat content of natural 
gas 

Use the “Heat Content [Btu/ft^3]” input box to modify the 
heat content. 

Change the carbon intensity of 
natural gas production 

Change the values in the “CO2e Emissions. (lb/therm)” 
column on the “GHG Emis. From Additional Natural Gas 
Production” panel.  

Change the fraction of renewable 
natural gas used to satisfy an 
increase in natural gas usage 

Change values in the “Supply Fraction” column on the “GHG 
Emis. From Additional Natural Gas Production” panel. NEAT 
assumes that all natural gas in the baseline case is from fossil 
sources, but uses the “Supply Fraction” and the “CO2e Emis. 
(lb/therm)” columns to model the carbon intensity of 
increased natural gas production. 

Change the Well-to-Pump emissions 
of transportations fuels 

Use the “Well-to-Pump Emis. of Transportation” panel to 
modify the CO2 equivalent and NOx emission factors of 
gasoline and diesel production. 

Add rooftop solar photovoltaics to 
every single-family and mobile home 

Use the “Implement Rooftop Solar PV using PVWatts” 
checkbox in the “Distributed Solar Photovoltaics” panel to 
add solar to every single-family and mobile home in the 
“Scenario” case. NEAT assumes that no homes have rooftop 
solar PV in the baseline case. It is not possible to relax this 
assumption. After selecting the checkbox, users will be able 
to modify relevant settings for the calculation. It is not 
possible to implement rooftop solar PV on multi-family 
homes in NEAT. 

Change the cost of rooftop solar PV After clicking the “Implement Rooftop Solar PV using 
PVWatts” checkbox in the “Distributed Solar Photovoltaics” 
panel, users will be able to modify the solar cost function in 
the “For Advanced Users” panel, which is used to model the 
cost of rooftop solar as a function of capacity. 

Change the assumptions used for 
calculation of the energy generated 
from rooftop solar PV 

Relevant parameters can be changed in the “For Advanced 
Users” panel within the “Distributed Solar Photovoltaics” 
panel. Select the “More Information” button at the bottom of 
the panel for a description of all relevant parameters. 

Change the emissions resulting from 
increased electricity demand  

The “Electricity Generation from Grid” panel contains a panel 
titled “Emission Factor of INCREASED Electricity Use.” Four 
options can be selected. Case 1 assumes that all additional 
electricity comes from sources without any NOx or GHG 
emissions (centralized photovoltaics, wind, and centralized 
battery storage). Case 2 assumes that additional electricity is 



7 
 

provided at the Basin-average dispatchable power emission 
factor. Case 3 assumes that all additional electricity is 
provided by peaker plants. The fourth option allows users to 
specify a mix of technologies by setting the percentage of 
each case. The “Electricity Generation Module 
Documentation” provides details for each of the three cases. 

Select how the emissions from a 
decrease in electricity demand are 
calculated. 

The “Electricity Generation from Grid” panel contains a panel 
titled “Emission Factor of REDUCED Electricy Use”. The 
“Electricity Generation Module Documentation” provides 
details for each of the three cases. 

Change how NEAT calculates the 
transmission and distribution loss in 
the power grid 

Three calculation options are available in the “Transmission 
and Distribution Loss in Power Grid” panel within the 
“Electricity Generation from Grid” panel. Users can select a 
flat loss percentage to use for all utilities, a hourly loss 
percentage to use for all utilities, and utility-specific loss 
percentages. Utility-specific loss percentages are editable 
directly. See “More Information” for details. 

Economics Panel 
Change or view the fraction of homes 
in each climate zone and housing 
category that are eligible for low 
income natural gas and electric rates 

Click the “View/Edit Low Income Fractions” button on the 
“For Advanced Users” panel within the “Low Income Rates 
Qualification” panel. This will open up the “Electricity Rate 
Structure Selector and Editor,” where users can view, edit, 
and save low income rate qualification percentages.  

Load saved set of low income 
fractions 

Click the “Load Saved Low Income Fractions” button on the 
“For Advanced Users” panel within the “Low Income Rates 
Qualification” panel. NEAT will look for files with an 
“.income” suffix, which can only be created with the 
Electricity Rate Structure Selector and Editor tool (see above). 

Change or view electricity rate 
structures 

Click the “View/Edit Rate Structures” button on the “For 
Advanced Users” panel within the “Electricity Rates” panel. 
This will open up the “Electricity Rate Structure Selector and 
Editor,” where users can view and edit electric rate 
structures. 

Load saved electric rate structures Click the “Load Saved Rate Structures” button on the “For 
Advanced Users” panel within the “Electricity Rates” panel. 
NEAT will look for files with a “.erate” suffix, which can only 
be created by saving a rate structure configuration in the  
“Electricity Rate Structure Selector and Editor” (see above). 

Define how new natural gas 
appliances are categorized for natural 
gas rate assignment 

All natural gas appliances must be categorized in the “Natural 
Gas Appliance Categorization” panel within the “Economics” 
tab. Users must select a checkbox only when adding a new 
natural gas fueled appliance technology that best describes 
the type of appliance. This categorization is used for natural 
gas rates that depend on the type of heat. 

Change or view natural gas rate 
structures 

Click the “View/Edit Rate Structures” button on the “For 
Advanced Users” panel within the “Natural Gas Rates” panel. 
This will open up the “Natural Gas Rate Structure Selector 
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and Editor,” where users can view, edit, and save natural gas 
rate structures. 

Load saved natural gas rate 
structures 

Click the “Load Saved Rate Structures” button on the “For 
Advanced Users” panel within the “Natural Gas Rates” panel. 
NEAT will look for files with a “.grate” suffix, which can only 
be created by saving a rate structure configuration in the  
“Natural Gas Rate Structure Selector and Editor” (see above). 

Allow for net metering Select the “Use Net Metering” button within the “Net 
Metering” panel 

Change how much the homeowner 
receives from excess electricity sold 
back to the grid 

After selecting the “Use Net Metering” button within the 
“Net Metering” panel, users will be able to select between 
two net metering options. A fixed rate per kW-hr must be 
specified if the user selects the “Sell Electricity Back to Grid at 
Fixed Rate” option. 

View or change the price for gasoline 
and diesel fuel 

Change the price of gasoline and diesel fuel in the “Gasoline 
and Diesel Prices” panel. 

Electricity Rate Structure Selector and Editor (Separate Tool) 

Open the “Electricity Rate Structure 
Selector and Editor” 

Click the “View/Edit Rate Structures” button in the “Electricity 
Rates” panel on the “Economics” tab 

Change or view the fraction of homes 
in each climate zone and housing 
category that are eligible for low 
income natural gas and electric rates 

Click the “View/Edit Low Income Fractions” button on the 
“For Advanced Users” panel within the “Low Income Rates 
Qualification” panel. This will open up the “Electricity Rate 
Structure Selector and Editor,” where users can view, edit, 
and save low income rate qualification percentages.  

Change of view the electricity rates 
that are assigned to each climate 
zone, housing category, or income 
qualification 

Click “More Information” on the “Rate Selector” tab for 
details. All electricity rate edits must be stored with the 
corresponding “Store” button and then saved with the “SAVE 
ALL TO FILE” button. 

Add a custom electricity rate Click “+Add Custom Rate” button on the “Rate Selector” tab. 
Click “More Information” on the “Rate Selector” tab for 
details. 

Save an edited set of rate structures 
to an “.erate” file 

Click the “SAVE ALL TO FILE” button 

Load an edited set of rate structures 
from an “.erate” file 

Click the “LOAD ALL FROM FILE” button 

Compare two electricity rates with a 
typical electricity use profile 

Select the “Analysis” tab. This panel is for informational use 
only and does not make any changes in the rate structures or 
electricity use profiles used in NEAT. 

Natural Gas Rate Structure Selector and Editor (Separate Tool) 

Open the “Natural Gas Rate Structure 
Selector and Editor” 

Click the “View/Edit Rate Structures” button on the “For 
Advanced Users” panel within the “Natural Gas Rates” panel. 
This will open up the “Natural Gas Rate Structure Selector 
and Editor,” where users can view, edit, and save natural gas 
rate structures. 

Change of view the natural gas rates 
that are assigned to each climate 

Click “More Information” on the “Rate Selector” tab for 
details. All natural gas rate edits must be stored with the 
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zone, housing category, or income 
qualification 

corresponding “Store” button and then saved with the “SAVE 
ALL TO FILE” button. 

Add a custom natural gas rate Click “+Add Custom Rate” button on the “Rate Selector” tab. 
Click “More Information” on the “Rate Selector” tab for 
details. 

Save an edited set of rate structures 
to an “.grate” file 

Click the “SAVE ALL TO FILE” button 

Load an edited set of rate structures 
from an “.grate” file 

Click the “LOAD ALL FROM FILE” button 

 

 

NEAT Test Case 

We recommend that users run a simple test case to ensure that the tool is behaving as expected. Make 

the following edits to a new instance of the NEAT tool: 

Demand Tab:  

1. Select Single-Family Housing Category 

2. Select “6 Coastal” for the Climate Zone 

3. Select the “Kitchen” tab 

4. Use the “Replace Technology Tool” to replace all natural gas range oven 

combinations with electric range oven combination 

 

Power Supply Tab:  

1. Check the “Implement Rooftop Solar PV using PVWatts” checkbox 
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After implementing the suggested changes, select the “Compute Results” button on the Computation 

slide. If the computation completed successfully, the first line in the output status should read “*** 

COMPUTATION COMPLTED SUCCESSFULLY!***”. This computation takes approximately 70 seconds on a 

modestly equipped South Coast AQMD computer (Intel Core i5-4570 CPU @3.20GHz with 8 GB RAM).  

One should then verify if the results are as expected. Go to the “Results” tab and select the “ANALYZE” 

button after the results have loaded.  Go to the “Apply Prescribed Funding” tab. With a default funding 

amount of $100000 and a 0% cost share by the homeowner (also default setting), the approximate 

number of projects funded should be 14. The cumulative change in NOx emissions in lb/yr should be -

8.68 and the cumulative change in CO2e emissions in lb/yr should be -1.12e6. 

  


